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Descartes Route Planner Installation Information 

Recommended System Requirements: 

The following minimum configuration is required to run Descartes® Route Planner™ 
(hereafter referred to as Route Planner): 

Database Servers 

Intel® Xeon® Processor E5 or better, 16 GB RAM at least 30 GB of available disk 
space on system partition.  Dedicated storage for Data and LOG preferred.  Size and 
IOPS requirements will wary per customer volume and throughput requirements. 
RAM requirements will also change, based on volumes, since Microsoft® 
Corporation’s SQL Server® operates better with more RAM.   

Microsoft® Corporation’s Windows® 2008 R2 or Higher 

SQL Server® 2008 or SQL Server® 2012 standard or enterprise edition 

Application 

Intel® Xeon® Processor E3 or better, 6-8 GB RAM, at least 30 GB of available disk 
space 

Software Requirements 

Microsoft® Corporation’s Windows® 2008 R2.  

 Note— On Windows® 2008, enable IIS 6.0 Compatibility 

Microsoft® Internet Information Services (IIS) -Common Files, Documentation, IIS 
Snap-In, Internet Services Manager (HTML), WWW Server 

Microsoft® XML Core Services (MSXML) 4.0 SP2 

Message Queue, configured for Independent Microsoft® Message Queueing (MSMQ) 

Microsoft® .NET Framework 4.0 

Microsoft® Silverlight® v2.0 or higher 

Client Computer 

Intel® Core™ i5-4440 Processor or similar 

• Microsoft® Windows® 7 Professional (64-bit) or higher 

• 4GB DDR3-1600 RAM 

Internet Explorer® 9.0 or later 

http://www.descartes.com/
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SQL Server® Requirements: 

If the Application Server and Database Server are in one workgroup, but not in one 
domain, then the SQL Server® should be running under the Administrator name (not 

under Local System Account). The Administrator name/password should be the same 
on both computers.  

 Note— If SQL is on a different host (recommended) the SQL Server® service 
must be running under a domain account (otherwise the restore process as 
part of the install will fail). 

To change the user name for the SQL Server®, go to Services and find MSSQL 
service. Right-click on MSSQL service and from the right-click menu, select: 
Properties. On the Log On page, select This Account and enter the Administrator 

user name and password. If the Application Server and Database Server are not in 
the same domain then refer to Appendix D. 

Notes for the User: 

1 Get the System Administrator (sa) password for the SQL Server® and the 
Administrator password for both machines. Get the SQL Server® name (click the 
cylinder icon on the SQL Server® machine and the server tag on the pop-up box 
will display the server name). 

2 Install the latest Windows® Service Packs and Message Queuing (MSMQ 
Windows® Component) on the machines (click Windows® Update from Start 
menu). Install latest service packs for SQL Server® on the SQL machine (from 
www.microsoft.com/sql). 

Account Requirements 

Route Planner requires a domain account which will be used for all running services 

and components. This account needs to be configured as a local administrator on 
each of the application servers. 

This service domain account needs to be configured in SQL with SysAdmin privileges.  

 Note— SysAdmin privileges are only required during new installations and 
upgrades. These privileges are not required for normal application usage. 

Windows® 2003 Application Server component requirements 

Route Planner (UI, Backend/Interface, BGO) 

 Windows® Components 
 IIS needs to be installed with the following components enabled 

 Standard components should be enabled 

http://www.descartes.com/
http://www.microsoft.com/sql
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 ASP.NET 

 ASP 

 Server Side Includes 

 Message Queuing 

 Standard components should be enabled 

 Active Directory Integration should be turned off 

 Other: 
 Domain account setup as local administrator to be used as a “service” 

account. 

 Install Microsoft® Silverlight® 

 Install Microsoft® .NET 2, 3 and 4. 

 This should be installed after IIS to ensure it is correctly configured for 
IIS 

Microsoft® SQL Server® 

 SQL Server® 2005, 2008, 2008R2: Mixed Mode installation is required. 

 Microsoft® Distributed Transaction Coordinator (DTC): Configured for No 

Authentication (see appendix for instructions) 

Windows® 2008 Application Server component requirements 

Route Planner (UI, Backend/Interface, BGO) 

 Roles: IIS needs to be installed with the following components enabled 

 HTTP Redirection 

 ASP.NET 

 ASP 

 Server Side Includes 

 Logging Tools 

 Basic and Windows® Authentication 

 Dynamic Content Compression 

 IIS Management Scripts and Tools 

 Management Service 

 IIS6 Management compatibility 

 Features: 
 Message Queuing 

 Standard components should be enabled 

 Active Directory Integration should be turned off 

http://www.descartes.com/


I N S T A L L A T I O N  G U I D E  

Descartes Route Planner 17.05 

  

  

 

 

The Descartes Systems Group Inc. |  T SX : DSG |  NAS DAQ :  DSGX |  120 Randall Drive, Waterloo, Ontario, N2V 1C6, Canada 

Toll Free 800.419.8495 |  Int‘l 519.746.8110 |  info@descartes.com |  www.descartes.com 9 

CONFIDENTIAL AND PROPRIETARY TO THE DESCARTES SYSTEMS GROUP INC. AND ITS AFFILIATES 

 Other: 
 Domain account setup as local administrator to be used as a “service” 

account. 

 Install Microsoft® Silverlight® 

 Install Microsoft® .NET 2, 3 and 4. This should be installed after IIS to 
ensure it is correctly configured for IIS 

Microsoft® SQL Server® 

 SQL Server® 2005, 2008, 2008R2: Mixed Mode installation is required. 
 Microsoft® DTC: Configured for No Authentication (see appendix for 

instructions) 

Components Included in this Installation 

This installation program will install all backend components and restore/upgrade 
databases for: 

 Core DCF – This is the framework that all LNOS applications are built upon. 
Creates the DCF Database. 

 Core DCF Security - the security framework, controls RBAC for each application 

and Users. Creates the DCFSec databases. 

 Core DCF UI – The website which allows you to make changes to the DCF 
configuration. 

 Route Planner – The enterprise level routing and scheduling solution. This is the 
components and database required to use the Route Planner system. (COM+ dlls, 
etc). 

 Route Planner UI – The website (UI) for Route Planner. 

 LNOS Panapi Legacy – This is the components for pathing and neighboring 
(show along the road). In 7.1.35 (and possibly earlier) all it is being used for is 
geofencing. 

 LNOS Reservations UI – This is the reservations UI used to create reservations 

through a UI instead of via an integrated solution (!) Not used very often. 

 LNOS Map Server – This is the component that allows Route Planner to display 
maps in the map quadrant. 

 Chart Engine – This is a graphing module used by multiple LNOS applications 

(Route Planner uses it for the route chart), also used by RPS. 

 BGO – Background Optimizer, this installs the BGO components. 

 FW Analyzer – This is a tool to allow running of reservation simulations, 
populating the database (buckets, orders, routes, etc) from a spreadsheet/access 

db. Typically used for ROI and basecase analysis. 

 Drawbridge Transformation XSL’s – very rarely used, Drawbridge has been 
replaced by Dataflow.  
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 Demo Map – this loads the n7mn_hennipen county map. Only use on the first 
install (if ever). 

 LMB Version 8.0 … - Europe only 

Configuring Components Separately 

Depending on your deployment requirements, User Interface Server clusters might 
be configured separately of Backend Interface Servers, Background Optimization 
servers, etc. 

In order to do this, different components are required for each server type. The most 
typical server “types” that users configured are: 

 User Interface Servers (UI): these servers are typically clustered for users to 
access the User Interface of Route Planner 

 Backend Interface Servers (BIF): These servers are typically clustered for 
external systems to post and integrate messages with Route Planner 

 Background Optimization Servers (BGO): These servers will be the optimization 
servers working 24x7. No need for clustering these servers. 

 Map Server: This will be the server that will be hosting the Mapping technology 
used by Route Planner. 

The following table explains what components should be installed on each server 
type: 
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Component  UI  BIF  BGO  Map Server 

Core DCF  X  X  X  

 

Core DCF Security  X  X  X  
 

Core DCF UI  X  X  X  
 

TOE  X  X  X  

 

TOE UI  X  X  X  

 

LNOS Panapi Legacy  X  X  X  

 

Fleetwise  X  X  X  

 

Fleetwise UI  X  X  X  
 

LNOS Reservations UI  X  X  X  
 

Microsoft® .NET Framework 4.0  X  X  X  X  

VC Redistributable VS2010  X  X  X  X  

LNOS License  X  X  X  

 

LNOS Map Server  X  X  X  

 

Chart Engine  X  X  X  
 

BGO  
  

X  
 

FW Analyzer  X  X  X  

 

In addition to components, the following table displays the type and number of 
services that should be configured when installing Route Planner. Each service has 
specific tasks that can execute: 
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 OPT UI: This type of Service will process any Optimization call triggered by a user 
via the User Interface of Route Planner (i.e. autoassign, suggest, drag and drops, 
etc. with the exception of an Optimize all call). 

 OPT: This service will take care of any optimization related call triggered by an 

integration XML or backend call. 

 OPT Async: This service will take care of any Optimize All calls done from the 
User Interface of Route Planner 

 Opt Disp: This service will take care of any status or gps update sent by Mobile 

Devices 

 Advise and Confirm: These services will take care of any Advise and confirm calls 
used in the reservations functionality. 

Below is a suggested Service configuration by Server type: 

 Note— Advise/Confirm should only be enabled when using reservations. Opt 
Disp should only be enabled when using status updates.  

 

Server 

Class  

OptUI  Opt  Opt 

Async  

Opt 

Disp  

Advise  Confirm  

UI  9  3  3  3  1  1  

BIF  3  9  1  9  6  9  

BGO  1  1  1  1  1  1  
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New Installations 

1 Run LNOSSetup.exe. 

2 From the Available Components tab, select all available products. 

 Note― The last Check box option “LMB Version 8.0…” is available only 
for some European countries (i.e. Spain). 

3 Click Next. 

 

4 From the Database Information tab: 

a Organization Name drop down box: Select an Organization from the drop-
down list box. For New installation you don’t have to create default 
Organization it will be create automatically during first installation. 

 Note— After first installation you may add new Organization, see 
Appendix E for more information. 

http://www.descartes.com/
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b Activating Route Planner License: a license key is required input for 
clients in order to run the Route Planner application. 

From the Database Information tab, click the Update GLNOrgID button. 
Enter an Organization ID and select the Apply GLNOrgID for ALL Orgs 
checkbox. 

 

A GLNOrgID is provided by Descartes to clients using the LNOS Installer. 

Once Installation is completed, Descartes Customer Support creates a license 
for the specific environment (Production or Lab) for the organization.  

To create a license, Customer Support needs following information from 
clients: 

 SQL Server® instance name 

 Database name 

Customer Support creates the license with selected properties enabled (BGO, 

Dispatch, Google™, Google Maps™, Planning, and Reservation). Once the 
license is created, it is published and an XML file is generated. and sent to the 
client. 

http://www.descartes.com/
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To use the XML file, find the LNOSLicenseTool.exe utility in the LNOS/bin 
directory. 

 

Most of the required information will already be entered. Fill in the following: 

 GLN Org ID, this is Customer ID 

 Application, this field needs to be set to LNOSFW 

 License File, this is the XML provided to the client 

When all fields are populated, the license can be installed. Click Install. The 
following confirmation message is returned when successful: 

 

In case the license is not installed successfully, please contact Customer 
Support. 

 Note— The Route Planner License XML must be imported seven days from its 
issue date. Beyond the seven day mark, the license is invalid and a new 
license XML must be requested from Descartes Customer Support. 
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c Some of the products you will install have related databases. For example, 
the Core DCF (backend) has to have the DCF database. The same applies to 
Route Planner backend.  

i Highlight the DCF profile in the grid and specify the SQL Server® name 
(server should be running),  

ii Type a database name (DCF is the default), it is not recommended to 
change default database names. 

iii Type sa for SQL Administrator Login and type password. 

d Default Database check box: Since COM components have only one 
connection string, you can choose only one database for the connection string 

to point to. If there is only one database, that database will be the default 
database. In the case of Route Planner, DCF is the default database.  

 Compatibility Level: Defaults to 90, but it could be set to 80 in case users 
would like to have SQL Server® 2000 compatibility level. 

e Click Save. Repeat this step for each profile in the database grid.  

f Click Next, and the installer will validate your database credentials. If it 
cannot access the database with the credentials or server name provided, a 
pop-up message will appear indicating an error. 

 Note— The install path is recommended for a non-OS partition (e.g. E). 
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5 From the Options tab, enter specific information for Route Planner. 

a Descartes Maps: Point system to the folder where you keep lmb/map files. 

Map/LMB File Path (RMPI): Tells the installer where the maps are for 

RMPI. It will only point to a directory and will grab up to 9 LMBs if they are all 
contained in the specified path. 

Map/LMB File Path (GCPI): Tells the installer where the maps are for 
GCPI. It will only point to a directory and will grab up to 9 LMBs if they are all 
contained in the specified path. 

Map/LMB File Name (Adapi and Panapi): (advise engine) requires the 
specific LMB file since it only supports one LMB. Click “…” to select a map on 
file. 

b Map File Path: empty as default it is pointed to 
c:\inetpub\wwwroot\GeoStream\Bin\data\gb.2.8. Additional instances can be 
added using the subsequent fields below Default. 
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c Services: Check Queues if you want to use them applicable only to Adapi and 
RMPI engines). The installer by default creates three Windows® services for 
each queue checked on except for the OPTAsync queue for which it only 
creates one. A maximum of three services per queue per Processor is 

recommended. If users have a four Processor server, then up to twelve 
services for each queue can be added.  

 Warning— If you have several application servers make sure you 

selected the same set of queues during installation at 
all these servers. 

 There are additional steps that you will have to execute in order to add more 
services than the default ones for each queue. Refer to Appendix A. 

d Time Out Values: Set default timeouts to 1,800 seconds. This can be 
changed depending on individual needs, but the user should not have to 
modify in general. 

e BGO Area Specifications: If you selected the Background Optimizer 

(BGO) setting on the Available Components page, enter the Name of the 
instances you want to create. Also see Appendix F for manual and additional 
BGO configuration. 

f Other settings: 

 Re-register COM components: If you want COM components to re-register 
during every installation, select the Reregister COM components check box 
(recommended/default). This setting should always be used during upgrades. 

 Check if components registered only: Select if you want the installer to 
check for registered components in this server. This will help when other DSG 
apps are already installed in this same server.  

 Load XMLs/Apps/Menus/Components: Select if you are upgrading your 

Route Planner database from a previous version (recommended/default). 
These are run for each organization.  

 Note: If you are installing this version in multiple servers pointing to the 
same databases, then this option can only be run during the first 

server installation. The rest of the servers can be installed with this 
option off once the first one has loaded these XMLs. 

 Load Text Keys XMLs: Select if you are upgrading your Route Planner 

database from a previous version. This option will import the new field 
translations and text keys required for the new version. 

 Note: – If you are installing this version in multiple servers pointing to the 
same databases, then this option can only be run during the first server 
installation. The rest of the servers can be installed with this option off once 
the first one has loaded these XMLs. 
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 Backup before installation: Select if you want to backup your current 
installation version before installing the latest version. Since it is a slow 
operation, it should only be used during upgrades. 

 Skip DB backup: Skips the database backup. 

 Clean up temp files: Select if you want Route Planner to purge temporary 
files. 

 Use DEMO Database during restore: Select if you want to restore the 
DEMO Database that comes with the installer. This database contains data 

from Minnesota, therefore a map containing this state must be provided.  

 Note — Do not check this option you want to start with an empty 
database. 

 Create separate INIs for each organization: Allows INI files to be defined 
by organization. Uses the same server to optimize problems in a more 
efficient manner with different geographies and optimization parameters.  

 No spaces in URL (Optional): Eliminates spaces in the map URL. 

 Contact Email (not used) 

 Company Name: Use this option to specify the company name to be used 
during login to the application. FW is the default company name, but can be 
changed based on user’s company name choice (i.e. Acme). 

 Default Language: Choose the default language in which Route Planner will 
be displayed from the drop-down menu. 

g Batch Processor Opt Task 

 RunOptTask Enabled 

 Pooling Interval 

 Route ThreadPoolSize 

h Batch Processor AVL Events 

 CheckAVLEvents Enabled 

 Polling Interval 

 Route ThreadPoolSize 

i Click Next. 
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6 From the Administrator Information tab: 

a Enter the Administrator User Name for Application Server. You should have an 
administrator user set for the Application Server computer. Enter an SQL 
Administrator Login and Password. 

 All DCF COM++ applications will run under this user. 

 If you do not have an administrator user, leave these text boxes blank.  In 
this case, COM components will be running under Windows® interactive user. 
The interactive UI allows the authentication protocol to obtain additional 
information from the user as needed during the course of the authentication 

session.  

 The System will generate a warning if the user does not exist in the list of 
logins  

b It is not recommended to change DCF-SQL login or password, this login will 

be automatically created at SQL Serverand all necessary permissions will be 
granted. 

c Select the Use Windows Authentication checkbox to  
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d Click Next 

 

7 From the Installation Path tab, specify the directory path where DCF will be 
installed: 

a LNOS Installation path is set to C:\LNOS. 

b BGO Installation path is set to C:\LNOS\fleetwise. 

c Click Next. 
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8 From the Finish tab, specify the following: 

a Diagnostics: click this option and the installer will run a diagnostic of the 
system based on your settings. This is an option to identify, in advance, any 
warnings that the installer may encounter. 

b Uninstall All: this option will uninstall all the applications from the server. 

c Cancel: this option will close the installer without executing any installations. 

d Install: this option will start the installation process. 

e Register COM: this is used when users only want to run the Registration of 
the COM components. This will not run all the msi’s contained in this installer. 

f Hidden Mode: this option allows you to run the installer without prompting 
you for questions when the installers are being run. This option allows you to: 

g Overwrite DBs:  
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 Yes: Use this option if you want to either use the demo database or start with 
a blank database. It will start with a blank database if the Use Demo 
Database during the restore check box in the Options tab was not selected. 

 No: Use this option if you want to keep your databases intact and just want 

to run the upgrade scripts to the current version. 

 “DCF” Only: Use this option only when you are upgrading your current Route 
Planner version and you don’t want to keep you DCF and DCF security 
databases. 

 

9 Click Install to begin the installation process. 
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10 Database creation (this option will only be shown when the installation is not run 
in a Hidden Mode): 

Installation application will create a new database if the product already has a 
dependent database.  

For example, DCF Core has DCF database, which was already created during 
previous installation. Installation will ask if user wants to overwrite the DCF 
database. 
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11 After installation: 

 When all products have been installed, the installation application will create 
COM components and register all necessary .DLLs. 

 Installation is complete. 
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How to Access Applications 

Open your Internet browser and go to the addresses mentioned below: 

Route Planner: 

http://localhost/LNOS%20FW%20UI/Default.asp 

Login Information: 

Administrator User 

Company Name: FW 

Login Name: FW-Admin 

Password: cs 

Planner User 

Company Name: FW 
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Login Name: FW-Planner 

Password: cs  

Dispatcher User 

Company Name: FW 

Login Name: FW-Dispatcher 

Password: cs 

ReadOnly User 

Company Name: FW 

Login Name: FW-ReadOnly 

Password: cs 
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Upgrading the Route Planner Version 

1 Copy new installer package to c:\Descartes\Installations 

2 Run LNOSSetup.exe 

3 Select Backup before Installation on the Options tab. All backups will be 
stored at c:\Descartes\Backups and databases will be backed up at SQL Server® 
side. 

 Select Hidden Mode. 

 Select No for Overwrite DBs. 

 Note— The Register COM components and Load XMLs options have to be 
checked on the Options tab. 

5 If you DO NOT wish to keep your Route Planner Data, then follow the steps 
below:  

 Run LNOSSetup and select what you want to install. At the last screen select 

Hidden mode and choose Overwrite DBs. 
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Appendix A: Adding New Services 

To add additional services, you need to register all services which came with the 
installer.  

Once this is done and you have selected the queue(s) on the Options tab of the 
LNOS Installation wizard, you will see the Add Service button under each selected 
queue after first successful installation.  

 Note― Make sure you only add the necessary services to avoid unnecessary 
CPU consumption. 

The steps below are an example of how to add Adapi/Advise Services. 

1 After running the LNOS Installation, open the LNOS Installation Wizard, and 
select the Options tab. Under Services, the Services Counter line will tell you 
how many services have already been added. 

 

2 Click Add Service under Adapi/Advise Queue. 

The Service Registration dialog box appears. 
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3 Click Yes to register the service. 

It will take about thirty seconds to create a new service. The Installation 
application will go to the DCF database and copy the first row for each given 
service name in the DCFProcess table and it will create a new row in the 

DCFProcessHost table based on the credentials you specified on the 
Administrator Information tab. It will register the additional service on your 
computer. The Finish tab will display all the available information. 

 

If for some reason your service did not register or it took longer than a couple of 
minutes, you can go to the DCF UI and try to register this additional service 
manually. More information in Appendix B. 
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If the additional service was added, you will see your new service on your 
computer’s Service List. 
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Installing the Message Queuing services (MSMQ) on Windows® 2000 or Later 
Versions 

The Messaging queue is a scalable system service developed by Microsoft® to enable 

high volume event processing. It is included with every Windows® 2000 version, 
although it is not always installed by default.  

To check if it is installed: 

1 From the Start menu, go to: Control Panel > Add/Remove Windows 
Components. The Windows® components wizard will appear.  

2 Check to see if a checkmark is present next to Message Queuing Service under 
the Application Server Component. 
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3 If there is no check mark selected, you will need to install the Message queuing 
service.  

 

To install it: 

1 Select the checkbox and click Next. You will need to have your Windows® 2000 
installation disc handy. 
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2 You will now be asked to select what type of queue to install. Select 
Independent client. 
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3 After selecting Independent Client, you will be asked if the Message Queue will 
be connecting to a directory service. Select Message Queuing service will not 
access a directory service. Click Next. The Message Queuing service will now 
be installed. 
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Appendix B: Finalizing the Setup of Queue Services 

 Note— This is manual process, for faster and recommended way to add 
services see Appendix A. 

The recommended number of queue services per processor for the Advise and Rmpi 
components is what the installer creates out of the box: three services per 
component. This will enable each processor to handle up to three calls at any given 
time. 

To finalize the Setup process, only when QUEUES are to be used, please follow the 
steps below. 

How to setup queues for Route Planner 

1 Login as Descartes Systems Group/DSGDeveloper/dev using this link: 
http://localhost/DCF/Default.asp 
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2 Using main menu go to DCF → SystemProcesses. 

 

3 You will see a list of processes to register but you need only these:  

 adapiExec1-3 

 optimizeExec1-3 

 confirmExec1-3 

 optimizeAsyncExec1 

 OptUI1-3 

 OptDisp1-3 
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4 Expand adapiExec1 and expand Server Registration. Make sure your account 
name is something like this: [Computer Or DomainName]\[UserName]. This 
was specified during installation on this screen.  
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5 Select available server and right-click. You will see drop-down menu – choose 
Register. 
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6 Click Register. After several seconds you will see this screen, which means the 
server is registered successfully. Do the same (starting with step 4) for the rest 
of the processes in step 3. If you have a problem with one process skip it and try 
to register it again at the end. 
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7 After you finish all ten of them, you will have ten services registered on your 
computer. To confirm, go to Desktop > My Computer, right-click and choose 
Manage from drop-down menu. You will see this screen: 
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8 You can restart you computer now, or to manually start these  services, right-
click and choose Start from drop-down menu. 
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Appendix C: Upgrading/Changing LMB Mapping Settings 

If customers have modified .Ini files and do not want to lose their settings, then 
perform the steps outlined below in the Manual Process; otherwise, perform the 
steps in the Automated Process. 

AUTOMATED PROCESS (no ini customization has taken place): 

1 Run the Route Planner Installation program. 

2 Click Route Planner and Map Server option only. 

3 Click Next until you get to the Options tab. Make sure you have filled in all 
relevant information on each preceding tab. 

4 Change the Map/LMB File Path (GCPI and RMPI) and the Map/LMB File 
Name (ADAPI and PANAPI) field values to point to where the new map is 
located. 

5 Click Next until you reach the Finish tab, and then click Install (Overwrite or do 
not overwrite databases is up to the user). 

MANUAL PROCESS (ini settings have been customized): 

 Go to all ini files in the LNOS\bin directory and change the map file 
name to use: 

RMPI and GCPI 

Files: rmpi.ini, Rmpi(X)_OPT_Q1.ini, gcpi.ini) 

Property Name: File1-9 (i.e. File1=D:\LMB\DCA3456789.lmb) 

 

ADAPI and PANAPI 

Files: adapi.ini, Adapi(x).ini, panapi.ini) 

Property Name: File (i.e. File=D:\LMB\DCA3456789.lmb) 

 

MAPSERVER: 

 Go to C:\Inetpub\wwwroot\LNOSMapServer 

 Edit the LNOSMapServer.reg file and change the following setting to the 
new map and number of maps to use: 

 "MapCount"=dword:00000001 

 "MapPath1"="c:\\LNOS\\Maps\\LMB\\DCA3456789.lmb" 

 Close and save the file 

 Double-click the file to execute the registry and then restart IIS. 
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Installing External Maps for Route Planner 

Route Planner users can specify a map server per organization. If users have several 
organizations each in a different geography and require different maps from different 
providers, the following steps can be followed to configure the application: 

To configure the map server URL for each company: 

1 Log into LNOS FW UI or DCF UI with the secadmin account. For example, fw/fw-
secadmin/cs. 

2 From Setup->Profile Items, search for the ‘org’ string using the Find button. 

Right-click on FWOrgLevelSettings, and click on Edit Org Item. 

  

3 On the Org Level Settings page, fill in the value for the URL for the Map Server 
and the following two fields: 

MapServerURL: Specifies what map server should be used for Geocoding 
(Optional). If not specified, the system will use the GCPI engine for geocoding. 

 If licensed to use Google™ maps, then select Google Maps™ for Map Source 
and URL leave it as default 

 If Map Source is GeoMicro, the URL must be input as follows: 

http://<GeoMicroServerName>/TileServer/ 
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Map settings for Geocoding 

GCPI: Select GCPI and the Geocoder URL value will be ignored 

DSG Geocoder: 

 

 Note— A DSG Geocoder Key must be supplied for the DSG Geocoder. 

Asset Gantt Chart Resource Labeling: Specifies the label shown in the Asset 
Gantt Chart when listing Routes. It could either use the ResourceKey or 
ResourceName. 

Now users under each company will be using the url that is configured for their 
company instead of the setting in config.xml. 

Configuring ini File Paths per Organization 

Route Planner users can define an ini files path per organization instead of this path 
being same for all organizations using the same application. This is done by 
configuring using the “Use separate ini per organization” installer option. The 

installer will create a LNOS\bin\INIs folder and will configure one subfolder per 
organization in the environment. It will set these paths in the CtySysValue table of 
each Route Planner database organization. The map files used by each organization 
need to be manually edited to configure maps and are no longer configured by the 
installer. 

By having ini files defined by organization, users can use the same server to optimize 
problems in a more efficient manner with different geographies and optimization 
parameters. It also removes the number of maps limit that the ini files impose, this 
limit still applies per organization. 

Configuring the External Map Server 

Route Planner installer allows users to have multiple map server projects installed in 
the same server. Users can specify different map server URLs depending on the 
geography and map server license that they own. 

Map server names and configurations must be specified at the time of installation. 
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Appendix D: LNOS Route Planner Configuation Settings 

Windows® Server® 2003 

 Note— LNOS Route Planner Installation will automatically configure the 
settings for Windows® Server® 2003 at Application server only. For SQL 
Server® machine no on the same domain refer to point 6. The following 
information is for you to check to verify that everything was set correctly.  

1 Check Enable Parent Paths for each web project. 

 a Once you have installed the UI in your server, go to IIS and right-click 
on the properties of every LNOS Virtual Folder.  

 b Click Configuration on the Properties page and go to the Options 
tab. Make sure this form matches the one below: 

  
2 For the LNOSMapServer to function, parent paths must be enabled and allowed 

as a Web Service Extension. Click Ok. 
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3 Click Add a new Web Service Extension link. 

 

4 Enter an Extension Name. Click Add and select the LNOSMapServer.DLL and 
select the Set extension status to Allowed checkbox: 
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5 If the database server is a Windows® Server® 2003, the following Microsoft® 
Knowledge Base article must be followed:  
http://support.microsoft.com/?kbid=555017 

6 Check security configuration for Microsoft® DTC especially for SQL Server® is 
Application and SQL Server® machines are not on the same domain 
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7 In the DCF COM+ component properties on the security tab, deselect Enforce 
Access Checks for this Application. 
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8 When the output XML from components exceeds 4MB, the Internet Information 
Server (ISS) will return an error. To fix this, perform the following: 

 Change the AspBufferingLimit setting in the Metabase.xml file to a larger size. 

The default value is 4,194,304, which is about 4 MB. Change this to whatever 
limit is reasonable for the types of files your users will be attaching. 

The maximum buffer size can be modified as follows: 

 a Stop IIS 

 b Locate the file %WinDir%\System32\Inetsrv\Metabase.xml 

 c Modify the AspBufferingLimit value 

 d Restart IIS 

9 If IIS displays the error, “Page Cannot be Found” while opening any page from 

any virtual directory, make sure the following settings are configured under IIS 
> Web Service Extensions:  
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If either of the Web Service Extensions is missing, please click Add a New Web 
Service Extension and add as follows: 

 A Active Server Pages 

 Extension Name: 

 Required Files: C:\WINDOWS\system32\inetsrv 

 Status: Allowed 

 b ASP .Net v1.1.4322 

 Extension Name: 

 Required Files: C:\WINDOWS\Microsoft.NET\Framework\v1.1.4322\ 
aspnet_isapi.DLL 

 Status: Allowed 

 

10 If you get the error “Named Pipe Error or Shape Size,” then apply the MDAC2.8 
Hot Fix included in the PreRequisites folder. 
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Appendix E: Adding a New Organization 

You can add new organizations from the LNOS Installation Setup. This functionality 
will help redirect some of the calls to different databases.  

To add a new organization: 

1 From the LNOS Installation page, click the Database Information tab. 

 

2 Click Add Organization. 

The NewOrganizationName dialog box appears. 

 

3 Enter your new organization name and GLN Org ID. 
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 Note— Do not use spaces and special symbols. 

 Note— Check Create Empty Database options if you do not want to keep 
any data from default database and you need to create empty databases 

 Note – Check Apply GLNOrgID for ALL Orgs 

4 Click Create New. 

After you click Create New, LNOS Installation will: 

 backup all databases on the SQL Server® side (this can take some time) 

 create new org name, etc. on the DCF database 

 update OrgName on the DCFSec database 

change views on the newly created databases 

If the new organization’s name appears in the Organization Name field box on 
the Database Information tab, your organization was created. 

If you do not see the new organization’s name appear, there will be an error on 
the Finish tab page. 

 Note— For now you cannot change your new organization’s database names. 

They are hard coded. For example, LNOSFW will be LNOSFW_YourOrgName. 

The login to the UI would be: 

[YourOrgName] 

FW-Admin 
cs 
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Appendix F: Multiple Scheduler Instances 

Once the first scheduler and BGO client have been setup using the installer, more 
instances can be installed as follows: 

1 Edit the fleetwise/scheduler/build.properties file to change the following 
properties to be set for the next instance of scheduler.  

default.port = 8081 

default.area = area23 

shutdown.port = 8010 

 Note— These are suggested values for a second instance. You will want to 
increment the default.port and shutdown.port and change the default.area 
name for each instance. 

2 At the Fleetwise\scheduler command prompt type: ant register-service and 

then ant register-optimizer.  

This will register another instance of scheduler and the BGO client. 

3 Setup the local.properties and optimizer.properties in the area folder just 
created. The local.properties will be the same as for the first instance of 
scheduler unless setting up dedicated BGOs.  

The optimizer.properties must have the following properties set differently from 
the first instance: 

com.descartes.escheduler.optimizer.live_url = 

com.descartes.escheduler.optimizer.work_url = 

com.descartes.escheduler.optimizer.scheduler_service_name 

com.descartes.escheduler.optimizer.scheduler_service_temp_path 

4 Repeat steps 1-3 for more instances. 
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Appendix G: Storing the Session Server Database 

Creating a SessionServer Database 

1 Log in to one of the ISS machines, and modify c:\Inetpub\wwwroot\LNOS FW 

UI\GeneratedFiles\Config.xml by adding the following attributes: 
SessionSQLDataSource=<sql server name> SessionSQLUserID=<sql login 

user that can create database> SessionSQLPassword=<login password>  to 

the Config element. 

 Note― The specified SQL login user needs to be able to create database. 

For example: 

Original Config.xml 

has 

<Config FEDebugMode="false" FETraceMode="false" 

FEProfilingMode="false"> 

Modified Config.xml 

would be 

<Config FEDebugMode="false" FETraceMode="false" 

FEProfilingMode="false" 

SessionSQLDataSource="Atlfleet-tmp3" 

SessionSQLUserID="sa" 

SessionSQLPassword="34x9d1f”> 

2 Restart World Wide Web Publishing (W3SCV) or IIS Admin Service. 

3 From the same machine, launch the application http://<server name>/LNOS FW 
UI, and then log in. 

This will cause the SessionServer database to be created. Please verify that it 
does exist on the specified SQL Server®. 

Modify all IIS Machines 

After the database is created, and for a more secure operation, a new login user can 
be created for accessing ONLY the SessionServer database. 

1 From the SQL Server® Enterprise Manager, under Console Root > Microsoft 
SQL Servers > SQL Server Group > (your server name) > Security, right-
click on Logins, and then click New Login. 

2 Under the General tab, fill in the Name, and under Authentication, click SQL 
Server Authentication, and fill in the password.  

3 Click the DatabaseAccess tab, and select SessionServer database checkbox.  

4 Select the db_owner checkbox under Permit in Database Role. 

5 Click the General tab, and specify SessionServer as the default database. 

6 Click Ok. 
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After you have finished these steps, you will have a new login user (e.g. login 
name = forSession and password = session). 

For each ISS machine (including the machine used in the Creating a SessionServer 
Database section above): 

1 Modify Inetpub\wwwroot\LNOS FW UI\GeneratedFiles\Config.xml by adding 

the following attributes (or replacing these attributes if they are there already): 
SessionSQLDataSource=<sql server name> SessionSQLUserID=<sql login 

user that can only access the SessionServer database> 

SessionSQLPassword=<login password> to the Config element. 

For example: 

Original Config.xml has <Config FEDebugMode="false" FETraceMode="false" 

FEProfilingMode="false"> 

Modified Config.xml 

should be 

<Config FEDebugMode="false" FETraceMode="false" 

FEProfilingMode="false" 

SessionSQLDataSource="Atlfleet-tmp3" 

SessionSQLUserID="forSession" 

SessionSQLPassword="session”> 

2 Restart the World Wide Web Publishing (W3SVC) or ISS Admin Service. From the 

Control Panel > Administrative Tools > Services, right-click on World Wide 
Web Publishing, and click Restart. 
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Appendix H: Configuring Route Planner for Load Balancing 

When Route Planner UI servers are clustered, additional configuration is required to 
maintain a user’s “session” between servers in the case of failover. By default the 
session information is only stored locally on the server. 

Clustering Requirements 

When clustering the Route Planner UI several different technologies can be used 
including Microsoft® Network Load Balancing (NLB) or a hardware load balancer 
(e.g. F5’s Big-IP). Regardless of the technology, utilized “sticky” sessions or “affinity” 
must be maintained because certain operations generate local files and the 
responding server needs to be the same for the entire duration of the task (not 
guaranteed without this affinity). 

Advantages of a Hardware Load Balancer 

A hardware load balancer dramatically improves the scalability and stability of an 
Route Planner environment. Unlike Microsoft® NLB it has the ability to detect if a 
host is healthy and if it is not it automatically removes it from the pool. This allows 
the RestartCOM health checks to identify and resolve the issue. When the server is 

healthy again (passes the configured tests) the load balancer adds the server back to 
the pool.  

A load balancer can identify an issue and react in a significantly reduced period of 
time. In an Microsoft® NLB environment a user (RP Admin, IT Admin) must first 

identify the issue, identify the problem host and then either remove it from the 
cluster or repair it. The time to resolution from initial onset of the problem is 
approximately 60 to 120 minutes. With a Hardware load balancer this is reduced to 
approximately one minute (configured testing interval). Switching from Microsoft® 

NLB to a hardware load balancer can reduce the number of visible outages by as 
much as 90 percent. 

Hardware Load Balancer Configuration 

A hardware load balancer will require two monitoring tasks: 

 Basic http check  

 Send String of “GET /” 

 Check for 200 “OK” status 

 Typically 5-30 sec between tests 

 Core http check 

 Send String of “GET /[APP]/Core/CtyXMLInterface/DCFListener.asp” 

 Expected response: “<Root>DCF HTTP Listener</Root>” 

 [APP] is the name of the application being tested: 
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 LNOS%20FW%20UI (UI/BIF) 

 LNOSFWUI (UI/BIF if using no spaces installer option) 

 STAD (BIF) 

 RPS (UI only) 

 Etc 

 Minimum interval is 60 sec between tests (less than this can cause stability 
issues) 

 If no response is received, a different response is received or an HTTP error 
code is received for ANY app on the host the node should be marked as down. 

 Note— These tests will verify most conditions when the application can fail 
but does not cover every situation. This does not verify the ability to perform 

optimization actions. That is handled through queue monitoring defined later 
in the document. Descartes has experience with the F5 BIG-IP device, a 
configuration guide can be found below. 

UI Clustering Tasks: LNOS Application Configuration 

Terminal Service to each server in the cluster and perform the following tasks: 

1 Login to the UI (http://server/LNOS%20FW%20UI) for all servers in the cluster. 
Use the following credentials: 

 Company: local 

 Username: configurationmanager 

 Password: changeme 

2 In the Web Farm section configure the following properties 

 SQL Session Server: <DBServer> 

 SQL Session User: <Username> 

 SQL Session Password: <pass> 

 Warning― The Username/password utilized needs the DB Creator 
role as it will create a new database on the server called 
“SessionServer” 

3 Alternatively, edit the following files on all servers in the cluster: 

 c:\inetpub\wwwroot\LNOS FW UI\GeneratedFiles\Config.xml 

 Add the following attributes to the “Config” element: 

 SessionSQLDataSource="<DBSERVER>"  

 SessionSQLUserID="<Username>"  

 SessionSQLPassword="<pass>" 

 Open http://localhost/LNOS FW UI/Core/Admintools 

 Click “Flush Cache” 

 Click “Reload Application” 

http://www.descartes.com/


I N S T A L L A T I O N  G U I D E  

Descartes Route Planner 17.05 

  

  

 

 

The Descartes Systems Group Inc. |  T SX : DSG |  NAS DAQ :  DSGX |  120 Randall Drive, Waterloo, Ontario, N2V 1C6, Canada 

Toll Free 800.419.8495 |  Int‘l 519.746.8110 |  info@descartes.com |  www.descartes.com 60 

CONFIDENTIAL AND PROPRIETARY TO THE DESCARTES SYSTEMS GROUP INC. AND ITS AFFILIATES 

  

http://www.descartes.com/


I N S T A L L A T I O N  G U I D E  

Descartes Route Planner 17.05 

  

  

 

 

The Descartes Systems Group Inc. |  T SX : DSG |  NAS DAQ :  DSGX |  120 Randall Drive, Waterloo, Ontario, N2V 1C6, Canada 

Toll Free 800.419.8495 |  Int‘l 519.746.8110 |  info@descartes.com |  www.descartes.com 61 

CONFIDENTIAL AND PROPRIETARY TO THE DESCARTES SYSTEMS GROUP INC. AND ITS AFFILIATES 

Testing Hardware Load Balancers 

Testing a UI Cluster 

1 Confirm SessionServer database is created on the database server. Open SQL 
Enterprise Manager and confirm database exists. 

2 Open Load balancer management page and verify each host in the cluster is UP. 

3 Confirm can still log into each of the applications. 

 Open http://cluster.domain.com/LNOS%20FW%20UI 

 Login to the application. 

4 Repeat testing for each node in the cluster 

5 Test failover: 

a Start 1 node and “suspend” others 

b Open http://cluster.domain.com/LNOS%20FW%20UI 

c Login to the application. 

d Start a different node and stop the first node 

e Perform operation in the UI 

 Note— User should remain logged in. 

Testing an Interface Cluster 

1 Confirm all nodes and pool are showing as UP 

2 Confirm can access interface URL from the vIP 

a Open 
http://cluster.domain.com/STAD/Core/CtyXMLInterface/DCFListener.asp 

b Verify response returned is <Root>DCF HTTP Listener</Root> 

3 Test Failover. Stop all nodes 

a Connect to all nodes in cluster using Remote Desktop 

b Stop STAD application in IIS Manager 

c Verify all nodes in pool are down 

d Open 
http://cluster.domain.com/STAD/Core/CtyXMLInterface/DCFListener.asp 

e Verify no response returned 

4 Verify each node 

http://www.descartes.com/
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a Connect to one node in cluster using Remote Desktop 

b Start STAD application in IIS Manager 

c Verify selected node in pool is up 

d Open 
http://cluster.domain.com/STAD/Core/CtyXMLInterface/DCFListener.asp 

e Verify response returned is <Root>DCF HTTP Listener</Root> 

f Stop STAD application in IIS Manager 

5 Repeat the verification for each node 

6 Start all nodes 

a Connect to all nodes in cluster using Remote Desktop 

b Start STAD application in IIS Manager 

  

http://www.descartes.com/
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Testing NLB Clusters 

Testing a UI Cluster 

1 Confirm SessionServer database is created on the database server. Open SQL 
Enterprise Manager and confirm database exists. 

2 Open NLB Manager and test each host in the cluster. 

a Right click on Network Load Balancing Cluster, choose Connect to Existing 
instead of “New Cluster” (Seen figure 1) 

b Type in name of a Node in the cluster and click connect. 

c Right click on all but one node and choose Drain Stop. 

d Once this is completed follow test procedure outlined below. 

3 Confirm can still log into each of the applications. 

a Open http://cluster.domain.com/LNOS%20FW%20UI 

b Login to the application. 

4 Repeat testing for each node in the cluster 

a Right Click on the next node in the cluster and choose Start. 

b Right click on the previous node used and choose Drain Stop. 

c Repeat test procedure. 

5 Start all nodes in the cluster to complete testing. Right click on each stopped 
node in the cluster and choose Start. Stopped nodes can be identified by a red 
icon beside the name. 

Testing an Interface Cluster 

1 Confirm can access interface URL from the cluster ip 

a Open 
http://cluster.domain.com/STAD/Core/CtyXMLInterface/DCFListener.asp 

b Verify response returned is <Root>DCF HTTP Listener</Root> 

2 Test Failover 

a Right click on Network Load Balancing Cluster, choose Connect to Existing 
instead of “New Cluster” (Seen figure 1) 

b Type in name of a Node in the cluster and click connect. 

c Stop All Nodes 

i Right click on all nodes and choose Stop. 

http://www.descartes.com/
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ii Open 
http://cluster.domain.com/STAD/Core/CtyXMLInterface/DCFListener.asp 

iii Verify no response returned 

d Verify each node 

i Right click on one node and choose Start. 

ii Open 
http://cluster.domain.com/STAD/Core/CtyXMLInterface/DCFListener.asp 

iii Verify response returned is <Root>DCF HTTP Listener</Root> 

iv Right click on one nodes and choose Stop. 

e Repeat the verification for each node 

f Start all nodes. Right click on each node and choose Start. 

3 Confirm can access interface URL from the cluster ip 

a Open 
http://cluster.domain.com/STAD/Core/CtyXMLInterface/DCFListener.asp 

b Verify response returned is <Root>DCF HTTP Listener</Root> 
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F5 Configuration: Configuration “Name” Placeholders 

[Partition] 

Recommended as an identifier to organize the entities, e.g. “LNOSFW” 

[APPUI] 

In a Route Planner standalone environment there are 2 possible “apps” 

 LNOS%20FW%20UI (or LNOSFWUI if no spaces installer options is used). This 
can be used on the UI or BIF servers 

 STAD. This is only used on the BIF servers 

[Partition] 

This is an identifier either for the company (in a multi-company environment) and/or 
environment (prod, test, etc) 

Pre-setup 

HTTP Profile 

 Name: http-wan-optimized-compression-xfwd 

 Parent Profile: http-wan-optimized-compression 

 Insert X-Forwarded-For (Click Custom): Enabled 

SSL setup 

 Upload pfx certificate to SSL certificates - need admin account 

iRule Setup 

 Create iRule: https_redirect_Preserve_URI. Code: 

when HTTP_REQUEST { 

       set host [HTTP::host] 

       set uri [HTTP::uri] 

       HTTP::respond 302 Location "https://$host$uri" 

    }  

Monitor setup 

Place Holders: 

http://www.descartes.com/
https://$host$uri/
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 [Partition] – recommended as an identifier to organize the entities, e.g. 
“LNOSFW” 

 [APPUI] – in a Route Planner standalone environment there are 2 possible “apps” 

 LNOS%20FW%20UI (or LNOSFWUI if no spaces installer options is used). 
This can be used on the UI or BIF servers 

 STAD. This is only used on the BIF servers 

 [Company/Env] can is an identifier either for the company (in a multi-company 
environment) or environment (prod, test, etc) 

 Create HTTP Monitor 

 Name: LNOS_[PARTITION]_Monitor_HTTP 

 Type: HTTP 

 Configuration: advanced 

 Interval: 30 seconds 

 Timeout: 16 seconds 

 Send String: GET /\r\n 

 Create HTTP  App core Monitor for each app (e.g. FW, STAD, RPS, TM, DRB) 

 Name: LNOS_[PARTITION]_Monitor_HTTP_[App]Core 

 Type: HTTP 

 Configuration: advanced 

 Interval: 60 seconds 

 Timeout: 16 seconds 

 Send String: GET /[APPUI]/Core/CtyXmlInterface/DCFListener.asp\r\n 

 Receive String: <Root>DCF HTTP Listener</Root> 

 Create HTTPS Monitor 

 Name: LNOS_[PARTITION]_Monitor_HTTPS 

 Type: HTTPS 

 Configuration: advanced 

 Interval: 30 seconds 

 Timeout: 16 seconds 

 Send String: GET /\r\n 

 Create HTTP  App core Monitor for each app 

 Name: LNOS_[PARTITION]_Monitor_HTTP_[App]Core 

 Type: HTTP 

 Configuration: advanced 

 Interval: 60 seconds 

 Timeout: 16 seconds 

 Send String: GET /[APPUI]/Core/CtyXmlInterface/DCFListener.asp\r\n 

 Receive String: <Root>DCF HTTP Listener</Root> 

http://www.descartes.com/
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Node setup 

Repeat for each node in cluster 

 Address: IP for server 

 Name: hostname 

 Health monitors: Node specific 

 Select Monitors (gateway_icmp) 

Pool setup 

HTTP Pool: 

 Name: LNOS_[Company/Env]_UI_HTTP 

 Configuration: Advanced 

 Health Monitor: LNOS_[PARTITION]_Monitor_HTTP 

 Availability Requirement: All 

 Allow SNAT: yes 

 Allow NAT: yes 

 Load balancing Method: Observerd (node) 

 Members: choose nodes and port 80 

HTTPS Pool: 

 Name: LNOS_[Company/Env]_UI_HTTPS 

 Configuration: Advanced. Health Monitor (choose each app in use): 

LNOS_[PARTITION]_Monitor_HTTPS_[App]Core 

 Availability Requirement: All 

 Allow SNAT: yes 

 Allow NAT: yes 

 Members: choose nodes and port 443. Inherit monitors from pool 

Virtual Server Setup 

HTTP VIP (UI Server, persistence required) 

 Name: VIP_LNOS_[Company/Env]_UI_HTTP 

 Type: Host 

 Address: Cluster IP 

 Service Port: 80 (HTTP) 

 Configuration: advanced 

 Protocol Profile (Client): TCP-wan-optimized 

 Protocol Profile (Server): TCP-lan-optimized 

 VLAN and Tunnel Traffic: Enabled on… [VLAN OF SERVERS] 

http://www.descartes.com/
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 HTTP Profile: http-wan-optimized-compression-xfwd 

 Clone Pool (Client): LNOS_[Company/Env]_UI_HTTP 

 Clone Pool (Server): LNOS_[Company/Env]_UI_HTTP 

 Last Hop Pool: LNOS_[Company/Env]_UI_HTTP 

 iRules: https_redirect_Preserve_URI 

 Default Pool: LNOS_[Company/Env]_UI_HTTP 

 Default Persistence Profile:  cookie 

 Fallback Persistence Profile: Source_addr 

HTTP VIP (Interface Server, persistence not required) 

 Name: VIP_LNOS_[Company/Env]_BIF_HTTP 

 Type: Host 

 Address: Cluster IP 

 Service Port: 80 (HTTP) 

 Configuration: advanced 

 Protocol Profile (Client): TCP-wan-optimized. Customer face, using wan otherwise 

lan (e.g. ag bif is customer facing) 

 Protocol Profile (Server): TCP-lan-optimized 

 HTTP Profile: http-wan-optimized-compression-xfwd 

 VLAN and Tunnel Traffic: Enabled on… [VLAN OF SERVERS] 

 Clone Pool (Client): LNOS_[Company/Env]_BIF_HTTP 

 Clone Pool (Server): LNOS_[Company/Env]_BIF_HTTP 

 Last Hop Pool: LNOS_[Company/Env]_BIF_HTTP 

 iRules:  https_redirect_Preserve_URI 

 Default Pool: LNOS_[Company/Env]_BIF_HTTP 

 Default Persistence Profile:  None 

 Fallback Persistence Profile: None 

 Save 

 Resources > Default Pool. Choose the pool. 

HTTPS VIP (UI Server, persistence required) 

 Name: VIP_LNOS_[Company/Env]_UI_HTTPS 

 Type: Host 

 Address: Cluster IP 

 Service Port: 443(HTTPS) 

http://www.descartes.com/
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 Configuration: advanced 

 Protocol Profile (Client): TCP-wan-optimized 

 Protocol Profile (Server): TCP-lan-optimized 

 HTTP Profile: http-wan-optimized-compression-xfwd 

 SSL Profile (Client): [ssl cert uploaded]_Client 

 SSL Profile (Server): [ssl cert uploaded]_Server 

 Only required if server has "require SSL" enabled in IIS, useful during 
migrations. 

 Not required otherwise and recommended to not to not do this long term as it 
increases workload on both BIG-IP and prevents offloading the SSL work from 
the server. 

 VLAN and Tunnel Traffic: Enabled on… [VLAN OF SERVERS] 

 Clone Pool (Client): LNOS_[Company/Env]_UI_HTTP 

 Clone Pool (Server): LNOS_[Company/Env]_UI_HTTP 

 Last Hop Pool: LNOS_[Company/Env]_UI_HTTP 

 iRules: none 

 Default Pool: LNOS_[Company/Env]_UI_HTTP 

 Default Persistence Profile:  cookie 

 Fallback Persistence Profile: Source_addr 
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Microsoft® NLB Configuration (Windows® 2003): Responsibilities 

Customers’ Responsibilities 

 Ensure each server in the cluster has individual monitoring.  

 Warning― Network load balancing is not application aware it provides load balancing 
at the port level (Layer 4). A node is considered to be “down” and non-
functional if it fails to respond to 5 (by default) consecutive heartbeat 
tests (occur at the MAC address level). 

 Any network configurations changes required, if deemed necessary during 
testing. 

 Determine cluster name and IP address. 

 Ensure servers have two Network Interface Cards per server if deemed to be 
necessary. 

 Note― The Microsoft® Best Practices recommends 2 Network Interface Cards 
per server, one for cluster traffic and one for node management. 

Descartes’ Responsibilities 

 Deploy Microsoft® NLB cluster for backend servers (using “No” affinity) 

 Deploy Microsoft® NLB cluster for UI servers (using “Single” affinity) 

 Configure all backend servers so they can handle Microsoft® NLB. 

 Configure SessionServer database for UI servers. 

 Train Customer employees in the use of Microsoft® NLB. 

http://www.descartes.com/
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Clustering Architecture 

FWDB

FWUI2FWUI1

BGO1

BGO2

BGO3

Background Optimizers

Customer Interface

Servers

FWIF1 FWIF3

FWIF2

Load Balanced Paths

New Path

Paths of Communication:

Backend Cluster

FleetwiseBE.acme.com

UI Cluster

Fleetwise.acme.com
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Setup and Configuration of NLB Clusters 

Preparation tasks 

For each server node to be added to the cluster, Confirm and/or configure static IP’s.  

 Note― Only Static IP’s are allowed by Microsoft® NLB. 

Record the IP Address, MAC Address, subnet mask and DNS Host name by opening a 
command prompt and executing “ipconfig /all”. 

 

Define the Cluster 

1 Define the new cluster with a single node. 

2 Connect to the first node to be added to the cluster. 

3 Open the start menu and navigate to Administrative Components > Network 
Load Balancing Manager. 

 

No = Static 

Yes = Dynamic 

http://www.descartes.com/
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4 When cluster manager finishes loading, right click on the “Network Load 
Balancing Clusters” and choose “New Cluster” as shown in Figure 1.  

 

Define the basic cluster configuration with the following components: 

 IP Address – This is the virtual IP address used to access the cluster. 

 Subnet Mask – This must be the same as all nodes in the cluster. 

 Full Internet Name – This is the Fully Qualified name as defined in DNS. 

 Note― This may need to be added to DNS manually. 

 Cluster Operation Mode – This must be set to multicast in a switch-based 

environment. 

 Network Address – This is the virtual MAC address for the cluster. Record this 
address in case manual configuration changes are required on the switch and/or 
router. 

 IGMP Multicast – Ensure this is turned off. 

 Allow Remote Control – Ensure this is unchecked as per Microsoft® Best 
Practices. 

http://www.descartes.com/
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5 Click Next to complete basic cluster configuration. 

6 Additional virtual cluster IP addresses can be configured at this time, but are not 
currently configured this way. 

 

7 Click Next to skip defining additional addresses. 

Define the port rules for the cluster. By default NLB defines a rule for ports 0 to 
65535. 

http://www.descartes.com/
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1 Select the rule and click Remove. 

2 The user will need to create new port rules. Port rules determine which TCP/IP 
port is handled and how. To add a new port rule click the Add button. The 
Add/Edit Port Rule dialog displays. 

  

3 Define the first rule for HTTP using the following settings: 

 Port Range – From 80 to 80 

 Protocols – Both 

http://www.descartes.com/
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 Filtering Mode – NONE, this ensures that backend calls will be distributed 
evenly across all nodes in the cluster this is deemed to be safe for 
synchronous backend calls. 

4 Click OK to complete this port definition. 

5 Define the first rule for HTTPS using the following settings: 

 Port Range – From 443 to 443 

 Protocols – Both 

 Filtering Mode – NONE, this ensures that backend calls will be distributed 
evenly across all nodes in the cluster this is deemed to be safe for 
synchronous backend calls. 

 

6 Click OK to complete this port definition. 

7 Click Next to complete the port configuration. 

First Node 

Finally, users need to connect the first node to the cluster by entering the host name 
or IP address (local) of the first node to be added to the cluster. 

1 Click on Connect. 

2 Choose the Interface that matches the IP address you recorded earlier for the 
node. 

http://www.descartes.com/
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3 Click Next to complete the Interface selection. 

4 Define the Host parameters. Use the following settings: 

 Priority – 1 This is the first node in the cluster 

 IP Address – do not change this 

 Subnet Mask – do not change this 

 Default State – Started 

 Retain suspended state after the computer restarts - check this. 

 Warning― If the server is put into a suspended state the only way to 
remove this suspended state is to manually resume the server. This 

does ensure that a server that has failed does not rejoin itself to the 
cluster. 

http://www.descartes.com/
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5 Click Finish. 

 Warning― This will cause slight network outage while the server 
reconfigures itself into the cluster. 

 

Enabling Logging 

It is important to enable logging to help troubleshoot issues during convergence and 
adding nodes to the cluster. 

To enable logging: 

1 Click on the Options menu, then Log Settings… 

 

http://www.descartes.com/
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2 Select the Enable Logging checkbox. 

3 Type the file path as follows: C:\Windows\System32\LogFiles\NLB_log.TXT 

 

4 Click OK to complete log configuration. 

Adding Nodes to the Cluster 

1 If not open already, open the Network Load Balancing Manager under the 
Administrative tools. 

2 Right click on the Network Load Balancing Cluster and select Add Host to 
Cluster. 

 

3 Specify the Host Name/IP address of the second Node to be added. 

4 Follow the steps laid out in section 1.6 however the priority of each node needs 
to be unique (e.g. priority 2 for node 2, priority 3 for node 3, etc.) 

 Warning― This will cause a slight network outage while each server 
reconfigures itself into the cluster. 

If the following error is displayed (with a yellow exclamation on the second host), 
note that it is typically caused by the existing node being unable to communicate 
with the new node while it is reconfiguring the network card. Wait a couple of 
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minutes and click the Refresh button, it should now show both as converged (all 
nodes green). 

 

Enable Multicast Support 

 Depending on the networking hardware used some configuration changes may be 
required on the switches and or routers.  

 Not all switches and routers will dynamically configure the following settings.  

 Based on the hardware at Customer sites the following commands most likely will 
need to be executed by Customer network team 

 On the switch: 

 The following command may need to be executed to manually configure the 

multicast MAC address on the switch for each port on the server. From the 
research completed the Cisco 2970 switch has difficulties registering this 
dynamically. 

o on a 2970 Cisco switch: mac-address-table static 03bf.ac10.321d eth0/5 

 On the router: 

 The following command may need to be executed manually to configure the 
multicast MAC address ARP entry. This allows the router to assign the 
multicast MAC address as the destination before passing the packet to the 
switch for delivery. 

 On a Cisco router: arp 172.16.2.29 03bf.ac10.321d ARPA 

 Warning― Without the proper configuration, multicast traffic will 
effectively turn a switch into a hub as it will be treated as broadcast 
traffic. This causes network congestion and poor performance for all 
servers in the same subnet. 

Confirm by connecting to both the switch and router and confirm the multicast MAC 
address registered correctly on both. Reconfirm after each node is added to the 
cluster. 

Testing the Microsoft® NLB Configurations 

Terminal service to each node in the cluster and perform the following: 

1 Go to the properties of the network card selected during setup for each Node and 
verify that the Microsoft® Network Load Balancing is checked. 
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 Note― On a multi-homed Server, ensure you choose the correct interface. 

2 Open a command prompt on each Node, and type IPCONFIG. 

3 Make sure that both Virtual IP address and the Original IP address for each node 
are bound to the same interface. 

4 From a command prompt, ping each node in the cluster and the cluster IP testing 
for connectivity. 

5 Terminal service to another server in the same network (IP/Subnet set) and use 
ping to test each node. 

6 From within the same network as the cluster ping the cluster IP and each node in 
the cluster. 

7 From outside the Microsoft® NLB cluster’s network ping the cluster IP and each 
node in the cluster. 

Additional Standard Port Rules 

If an FTP configuration needs to be deployed the following rules should be used. 

 IP: All, port 20-21, Protocol: Both, Mode: Multiple, Affinity: Single 

 IP: All, port 57000-57999, Protocol: Both, Mode: Multiple, Affinity: Single 
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Appendix I: Network Considerations 

The table on the following page illustrates a typical usage pattern for 240 total users 
(across four time zones) audited from the IIS logs of a production server. Using an 
external map display. 
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Time 

of Day 

Sent 

KB/Hr 

Recv 

KB/Hr # Posts # Opt 

Avg 

Concurrent 

Users 

# Posts 

/ User  

/ Min 

# Opt / 

User 

/ Min 

 
666,619.9 548,409.6 107,135 7,306 20.4 180.5 11.8 

0 6,590.6 6,440.4 1,118 70 6.7 166.0   10.4  

1 4,315.4 3,692.0 805 68 4.9 165.4   14.0  

2 957.8 1,530.6 282 2 3.3 86.8   0.6  

3 814.9 1,366.1 237 3 3.0 79.9   1.0  

4 127.9 959.0 151 0 2.5 60.0   -    

5 127.1 953.1 150 0 2.5 60.0   -    

6 127.9 959.0 151 0 2.5 60.0   -    

7 127.9 959.7 151 0 2.5 60.0   -    

8 1,105.2 1,658.0 364 14 2.9 124.8   4.8  

9 15,271.3 8,193.5 2,139 194 7.6 280.2   25.4  

10 32,079.5 20,427.1 5,427 504 14.3 380.4   35.3  

11 50,884.6 33,213.4 8,200 755 24.8 330.9   30.5  

12 53,008.2 38,078.6 8,373 651 32.5 258.0   20.1  

13 66,224.0 52,451.5 10,800 761 43.1 250.9   17.7  

14 71,026.1 57,548.0 11,026 766 46.4 237.5   16.5  

15 48,094.9 45,721.4 7,818 346 41.6 188.2   8.3  

16 50,651.0 44,644.5 7,876 449 39.9 197.6   11.3  

17 52,664.9 47,431.4 8,754 532 43.4 201.9   12.3  

18 57,435.6 49,910.1 8,888 541 43.5 204.3   12.4  

19 54,255.8 45,662.0 8,720 570 42.3 206.2   13.5  

20 51,020.3 42,308.5 7,955 556 37.2 213.9   15.0  

21 33,015.7 28,305.7 5,050 371 23.7 212.8   15.6  

22 10,069.2 9,593.0 1,627 76 10.9 149.5   7.0  

23 6,623.6 6,402.8 1,073 77 6.8 157.4   11.3  

Table Legend: 

 Time Of Day: The hour of the day 
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 Sent KB/Hr: traffic sent by the server(s) 

 Received KB/Hr: traffic received by the server(s) 

 # Posts: The number of HTTP Posts received by the server(s) 

 # Opt: The number of requests requiring the optimizer (RMPI) 

 Avg Concurrent Users: The number of distinct users performing an operation 
within the same minute. 

 # Posts / User / Min: # Posts divided by number of Concurrent Users 

 # Opt / User / Min: # Opt divided by number of Concurrent Users 

 

http://www.descartes.com/


I N S T A L L A T I O N  G U I D E  

Descartes Route Planner 17.05 

  

  

 

 

The Descartes Systems Group Inc. |  T SX : DSG |  NAS DAQ :  DSGX |  120 Randall Drive, Waterloo, Ontario, N2V 1C6, Canada 

Toll Free 800.419.8495 |  Int‘l 519.746.8110 |  info@descartes.com |  www.descartes.com 85 

CONFIDENTIAL AND PROPRIETARY TO THE DESCARTES SYSTEMS GROUP INC. AND ITS AFFILIATES 

Appendix J: Microsoft® DTC setup for SQL 

Windows® Server 2008/Windows® 7 (PC) Microsoft® DTC setup 

Microsoft® DTC needs to be configured for “No Authentication” manually on the SQL 
Server®. The installer does not have permissions to configure this during the install 
of the application server. 

1 Go to Component Services, Expand to reveal My Computer. 

2 Right click on My Computer and select Properties from the right-click menu. 

3 Select the Default Properties tab. 

 

4 Select the Enable Distributed COM on this computer checkbox. 

5 Expand My Computer, right click on Local DTC and select Properties from the 
right-click menu. 
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6 Configure settings as shown in the screenshot above. 

Windows® Server® 2003 Microsoft® DTC Setup 

Microsoft® DTC needs to be configured for “no authentication” manually on the SQL 

Server®. The installer does not have permissions to configure this during the install 
of the application server. 

1 From Component Services, expand My Computer. 

2 Right click on My Computer and select Properties from the right-click menu. 

3 Click the Default Properties tab. 
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4 Select the Enable Distributed COM on this computer checkbox. 

5 Select the MSDTC tab and click Security Configuration. 

http://www.descartes.com/


I N S T A L L A T I O N  G U I D E  

Descartes Route Planner 17.05 

  

  

 

 

The Descartes Systems Group Inc. |  T SX : DSG |  NAS DAQ :  DSGX |  120 Randall Drive, Waterloo, Ontario, N2V 1C6, Canada 

Toll Free 800.419.8495 |  Int‘l 519.746.8110 |  info@descartes.com |  www.descartes.com 88 

CONFIDENTIAL AND PROPRIETARY TO THE DESCARTES SYSTEMS GROUP INC. AND ITS AFFILIATES 

 

6 Configure the security settings as shown below. 
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Appendix J: Application Health Maintenance 

Route Planner 

RestartCOM Overview 

Route Planner has several built-in health-check functions contained in the 
RestartCOM utility. The installer automatically creates these tasks as Windows® 
scheduled tasks on each server when first installing route Planner, these tasks 
should be reconfigured as needed for the local environment. 

RestartCOM Task 

This task should run daily at a time that will not interfere with production activity. It 
is recommended to stagger the time for similar class servers so not all servers are 
down at the same time. This task will restart all application and OS level components 
used by the application to ensure optimal performance. 

TestDCFFrontend 

This task should run at most every 10 minutes and at least once per hour, typically 
runs every 30 minutes. The execution time should be staggered with 
CheckDCFBackend to ensure the two tasks do not interfere with each other. This task 
checks the application pools for each installed application and will recover them if an 
issue is detected 

HKLM\Software\DCF\RestartCOM\RestartTimeOut, recommended value is 45000 (45 
sec). 

TestDCFBackend 

This task should run at most every 10 minutes and at least once per hour, typically 
runs eveyr 30 minutes. The execution time should be staggered with 
CheckDCFFrontend to ensure the two tasks do not interfere with each other. This 
task checks the backend component and will recover the component if an issue is 
detected. This is a “lighter” test then CheckDCFBackend. 

HKLM\Software\DCF\RestartCOM\RestartTimeOut, recommended value is 45000 (45 
sec). 

TestDCFServices 

This task should run at most every 10 minutes and at least once per hour, typically 
runs every 45 minutes. This task checks the virtual bytes memory usage of each 
DCF* and FW* service, if the service is over the configured limit it restarts the 
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problem services individually. The memory limit is configured in the registry at 
HKLM\Software\DCF\RestartCOM with the MemoryUsagePercentage string. For four 
gigabyte servers this should be configured at 8 percent for a two gigabyte server this 
should be configured at 20 percent which is the default value when installed. 

TestDCFMsmq 

This task should be disabled. 

IIS Post-Install configuration 

Configure RP App Pool Properties 

For all application pools disable Rapid-fail Protection. 
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Database Monitoring 

DB Blocking Test 

This test looks for processes that cause blocks to other processes for extended 
periods of time. These types of blocking can lead to general slowness or 
unresponsiveness. It is recommended to setup a process that looks for these and 
alerts if its over a certain threshold. 

 

Database Scheduled Tasks 

Security Trace Purge 

Recommended to run daily or weekly by calling the CleanupSec stored procedure in 
the DCFSec databases. The parameter provides the number of days to retain. 

Tracking Log Purge 

Recommended to run daily or weekly by caling the CleanupTracking stored procedure 
in the LNOSFW database. The parameter provides the number of days to retain. 

Backups (and Recovery Model) 

A regular backup schedule should be implemented, below is the recommendations by 
backup type. The backups should be saved to a non-local disk or backed up to non-

local disk regularly otherwise in the case of failure the backups may not be available 
for recovery. 

 

Database Recovery Model FULL DIFF TLOG 

DCF Simple Weekly/Daily Daily/NA N/A 

DCFSec Simple Weekly/Daily Daily/NA N/A 

DCFSec_xxx Simple Weekly/Daily Daily/NA N/A 

LNOSFW Full Weekly/Daily Daily/NA Hourly 

LNOSFW_xxx Full Weekly/Daily Daily/NA Hourly 

ShipperTAD Simple Weekly/Daily Daily/NA N/A 
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ShipperTAD_xxx Simple Weekly/Daily Daily/NA N/A 

Reindex 

Recommended to run daily or weekly as needed. This can be done by executing the 
Reindex_all_table stored procedure in each database. No parameters required. 

Old Locks Cleanup 

It is recommended to run this task every 15 minutes, any locks older than two hours 
will be removed. This prevents old locks from impacting operations (preventing 
optimize all or other transactions). This task is executed in the LNOSFW databases 
(LNOSFW, LNOSFW_xxx). 

--Delete locks older than 2 hours 

delete from FwOptLockStatus 

where datediff(n,Modifydate,getdate()) > 120 
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Appendix K: Infrastructure and Recommendations 

Redundancy 

If you are using Route Planner as an application that you consider critical, it is 
recommended that best practice redundancy be implemented. At a minimum it is 
recommended that the web UI and interfaces servers are in a load balanced cluster 
for both scalability and redundancy. Depending on the size of the implementation 

these two classes of servers are put into separate load balanced clusters. At this time 
“Sticky” connections are required for the web UI cluster. It is recommended that 
enabling connection persistence by cookie in the hardware load balancer device (e.g. 
F5 BIG-IP). For interface servers Affinity/Sticky connections is not required and is 
not recommended as it prevents the even work distribution.  

The database servers should be clustered in an active/passive Microsoft® SQL 
Server® Cluster. 

BGO Servers do not require external clustering methods as the application internally 
manages the load between the available servers, having at least one additional BGO 
server is recommended to allow for full capabilities in the case of a server failure.  

Servers and Virtualization 

At this time, virtualization for the Route Planner application servers is recommended; 
the VM Size is 4-core and 4 gigabytes of RAM. Web UI and Interface servers can be 

“overloaded” to allow both scalability and redundancy as the usage on these servers 
varies throughout the day. It is highly recommended that BGO servers have a 
reserved CPU and memory as these servers typically run at greater than 75 percent 
CPU usage at all times. 

Each server should have at least 30 gigabytes of disk space allocated in a partition 
for Route Planner (excluding operating system). This will provide enough space for 
two versions of the map files, several versions of the installers and the application 
itself. It is recommended that the application is installed on a separate partition from 
the operating system. 

No host should have more than 75 percent of its memory allocated to virtual 
machines. Exceeding 75 percent has caused noticeable performance degradation to 
the virtual machine performance in the form of high processor queue lengths. In 

certain instances hyper-threading has been required to be disabled for similar 
reasons. As an example a physical host with 16 gigabytes of ram should not have 
more than 12 gigabytes of memory allocated for virtual machines (e.g. three VM’s 
with four gigabytes each of six VM’s with two gigabytes each, etc.). 
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Network Stability 

Network stability is key to receiving consistent performance out of Route Planner. 
The individual requirements will vary from customer to customer however the 

following minimum requirements should be met to ensure a consistent performance 
from the application. The application will operate at values lower than those listed 
but there will be a measurable difference in performance; e.g. ping times of 150ms 
could decrease the performance 10 to 20 percent. Higher bandwidth can make up for 
higher latency or vice versa. 

Proxy Considerations 

 Proxy’s can/will decrease the performance of the application. 

 Proxy’s should never be utilized between host systems and interface servers. 

 Proxy’s should never be utilized between tunnel server and interface servers. 

 Proxy’s should be assessed regularly to ensure they are capable of handling the 
increased load. 

Full T1 connection to Route Planner (or higher) 

 There is a large amount of dynamic data being passed, a T1 connection is the 
minimum recommended speed to ensure the users performance is not 
significantly impacted. 

 More fields being displayed on the dashboard requires more information to be 
sent, minimizing the number of columns reduces the load on the network. 

The network connection should have at least 20-40 percent capacity 

 If the connection is too heavily allocated the performance of the application will 
suffer, this is especially important during peak RP usage periods. 

Latency should be less than 90ms on average  

 The results of a ping test should be fairly consistent. 

 Erratic ping times should be investigated, as they will lead to erratic slowness in 
the application 

Ping loss should be less than 1 percent peak periods 

 The occasional dropped packet is not unexpected, but consistent ping loss 
indicates an infrastructure problem and can lead to reduced performance of the 
application  

 Dropped packets can lead to users believing the application is “down” when in 
fact their request was never received by Route Planner. 

HTTP traffic should not have reduced priority 

 As Route Planner is a mission-critical application and is web-based, HTTP traffic 

to Route Planner is critical and should not be marked as reduced priority. 

 Reduced priority traffic can lead to the same symptoms as ping loss or erratic 
ping results, and users will encounter slowness or no response at all. 
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Load Balancing Configuration 

A hardware load balancer improves the scalability and stability of an RP 
environment. Unlike NLB it has the ability to detect if a host is healthy and if it is not 

it automatically removes it from the pool. This allows the RestartCOM system health 
checks to identify and resolve the issue. When the server passes the configured 
tests, the load balancer adds the server back to the pool.  

A load balancer can identify an issue and react in a significantly reduced period of 

time. In an NLB environment a user (RP Admin, IT Admin) must first identify the 
issue, identify the problem host and then either remove it from the cluster or repair 
it. The time to resolution from initial onset of the problem is approximately 60 to 120 
minutes. With a Hardware load balancer this is reduced to approximately 1 minute 

(configured testing interval). Switching from NLB to a hardware load balancer can 
reduce the number of visible outages by as much as 90 percent. 

A hardware load balancer will require two monitoring tasks: 

 Basic http check  

 Send String of “GET /” 

 Check for 200 “OK” status 

 Typically five to 30 sec between tests 

 Core HTTP check 

 Send String of “GET /[APP]/Core/CtyXMLInterface/DCFListener.asp” 

 Expected response: “<Root>DCF HTTP Listener</Root>” 

 [APP] is the name of the application being tested: 

 LNOS%20FW%20UI (UI/BIF) 

 LNOSFWUI (UI/BIF if using no spaces installer option) 

 STAD (BIF) 

 RPS (UI only) 

 Etc 

 Minimum interval is 60 seconds between tests (less than this can cause 
stability issues) 

 If no response is received, a different response is received or an HTTP error 
code is received for ANY app on the host the node should be marked as down. 

 Note— These tests will verify most conditions when the application can fail 
but does not cover every situation. This does not verify the ability to perform 

optimization actions. That is handled through queue monitoring defined later 
in the document. 

Monitor Alerting 

In order to ensure maximum availability of the Route Planner application, the 
following is recommended as a minimum set of monitoring measures to alert on. 
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Basic Monitoring 

When available disk space is less than 10 percent on a drive, an alert is sent. 

If 2 consecutive ping tests fail, an alert is sent. 

When CPU usage exceeds 80 percent, an alert is sent. This parameter should not 
apply to BGO Servers. 

When memory usage exceeds 80 percent, an alert is sent. 

The following Windows® services should always be running: 

 Task Scheduler Service 

 Terminal Services Service 

 Windows Time Service 

 COM+ Event System Service 

 COM+ System Application Service 

 World Wide Web Publishing Service 

 MSMQ Service 

 Workstation Service  

 Server Service  

 All Automatic Services need to be running and responding 

Pool Monitoring 

An alert is generated if all members in a pool are down or if one member in the pool 
is down for more than 30 minutes (this time is provided as a recommendation only). 

Application Specific Monitoring 

Tunnel 

Ensure Descartes Mobilelink Tunnel service is running on one server. 

UI Servers 

UI Operations Monitoring: 

If possible it is recommended to perform a basic login test using a “replay” 
monitoring tool that can perform a UI login, perform a series of basic actions and 
then logout. It is recommended to run this test every 30 minutes.  

A typical test would be: 

 Login to the application 

 Navigate to Data > Schedules menu item 

 Locate a specific schedule (typically a test schedule) 

 Edit the schedule (double click) 
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 Click Save 

 Logout 

Specific Service Monitoring: 

Ensure at least one of each service class is always running. 

 DCF$Optimize Svc 1 

 DCF$OptUI Svc 1 

 DCF$OptAsync Svc 1 

Queue Monitoring: 

Depending on the server size the queue monitoring will vary as follows. 

4 core server: 

MSMQ .\private$\lnosfw_optui_q1 – Alert if queue count > 9 

MSMQ .\private$\lnosfw_opt_q1 – Alert if queue count > 3 

MSMQ .\private$\lnosfw_optasync_q1 – Alert if queue count > 2 

8 core server: 

MSMQ .\private$\lnosfw_optui_q1 – Alert if queue count > 24 

MSMQ .\private$\lnosfw_opt_q1 – Alert if queue count > 3 

MSMQ .\private$\lnosfw_optasync_q1 – Alert if queue count > 4 

BIF Servers: 

Specific Service Monitoring: 

Ensure at least one of each service class is always running. 

DCF$Optimize Svc 1 

DCF$OptDisp Svc 1 

IIS Application pool monitoring: 

Ensure the following application pools are always running. 

 LNOSFW 

 STAD 

Queue Monitoring: 

Depending on the server size the queue monitoring will vary as follows. These values 
are determined by the number of services allocated to each function. If the number 
of messages in the queue exceeds the number of services this indicates the request 
is waiting for a service to process it and should generate an alert. 

2 core server: 

MSMQ .\private$\lnosfw_optdisp_q1 – Alert if queue count > 4 
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MSMQ .\private$\lnosfw_opt_q1 – Alert if queue count > 4 

4 core server: 

MSMQ .\private$\lnosfw_optdisp_q1 – Alert if queue count > 9 

MSMQ .\private$\lnosfw_opt_q1 – Alert if queue count > 6 

8 core server: 

MSMQ .\private$\lnosfw_optdisp_q1 – Alert if queue count > 18 

MSMQ .\private$\lnosfw_opt_q1 – Alert if queue count > 9 

BGO Servers: 

Service Specific Monitoring: 

FW_Optimizer_* should always be running 

FW_Scheduler_* should be explicitly not monitored as these services restart on a 
regular basis as determined by the Optimizer service. 

HTTP Monitoring: 

URL: http://[server]/LNOS%20FW%20UI/Core/CtyXmlInterface/DCFListener.asp 

Expected response: <Root>DCF HTTP Listener</Root> 
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Appendix L: Configure Custom Manifests 
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Appendix M: Install LMB Map Files 

This appendix describes the step-by-step instructions to add or remove new maps for 
Descartes Route Planner. There are two types of map installations: Map Replacement 
and Map addition/removal. 

This process will require a server outage, if a cluster is being utilized this can be 
done on one node at a time by pulling it out of the cluster prior to execution 
otherwise notification to the users and interface shutdown may be required. 

Preparation 

1 Enter the name of the new map(s) 

2 Enter name of the map(s) to remove. List of Route Planner servers: 

 User Interface (UI) 

 Backend InterFace (BIF/BE) 

 BackGround Optimizer (BGO) 

4 Identify the map paths 

5 Run LNOSSetup.exe 

 Note— Do not select any of the available components. 

6 Click the Options tab 

 

 Map/LMB File Path (RMPI): This is the path for the map files used by the 
pathing engine. 

 Map/LMB File Path (GCPI) This is the path for the map files used by the GCPI 
geocoding engine. 

 Map/LMB File Name (Adapi and Panapi) This is the name of the individual 
map file used by the reservations engine. 

Map Replacement Overview 

When replacing maps the name of the map file remains constant and no pointers 

need to be modified, the only requirement is to swap the map files. These files are 
constantly in use so all components and services need to be shutdown in order to do 
this. 
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Instructions 

Terminal Service (Remote Desktop) to the Route Planner server. If in a load 
balanced cluster use the cluster tool to mark the node as “down” or “stopped”. 

1 Open Component Services and select Computers > My Computer > 
Applications. 

2 Locate the DCF component, right click and choose Disable 

3 Run [drive]:\lnos\bin\RestartCOM.exe or select it from the desktop shortcut. 

 Note— If using Windows® 2008 you will need to Run as an Administrator 

4 Click Stop Services. 

5 Navigate to the map folder (typically [drive]:\maps\...) 

6 Copy the existing map(s) to be replaced into a backup folder (e.g. 
c:\descartes\maps\old\). 

 Note— it is recommended that the previous map always be available in case 
issues are later identified and a rollback is required. 

7 Move the new map(s) into the map folder replacing the existing file(s). 

8 Run [drive]:\lnos\bin\RestartCOM.exe or select it from the desktop shortcut 

 Note— If using Windows® 2008 you will need to Run as an Administrator 

9 Click Start Services. 

10 Locate the DCF component, right click and choose Enable. 

11 Perform the verification tasks described in the sections below. 
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Add/Remove LMB Maps for Route Planner 

When add/removing maps the name of the map file changes, the installer needs to 
be re-run to update all configuration files related to these new map files.  

Instructions 

Terminal Service (Remote Desktop) to the Route Planner server. If in a load 
balanced cluster use the cluster tool to mark the node as “down” or “stopped”. 

1 Open Component Services expand Computers > My Computer> 
Applications 

2 Locate the DCF component, right click and choose Disable. 

3 Run [drive]:\lnos\bin\RestartCOM.exe or select it from the desktop shortcut. 

 Note— If using Windows® 2008 you will need to Run as an Administrator 

4 Click Stop Services. 

5 Navigate to the map folder (typically [drive]:\maps\...). 

6 Copy the existing map(s) to be replaced into a backup folder (e.g. 
c:\descartes\maps\old\). 

 Note— It is recommended that the previous map always be available in case 
issues are later identified and a rollback is required. 

7 Move the new map(s) into the map folder replacing the existing file(s). 

8 Locate the DCF component, right click and choose Enable. 

9 Run LNOSSetup.exe. 

10 Do not select any of the available components. 

11 Click the Options tab. 

 

12 If the file specified in Map/LMB File Name (Adapi and Panapi) no longer 
exists. 

13 Click the “…”choose one of the existing or new maps. 

14 Preferably a large coverage map (e.g. n7us). 
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15 Ensure Load XML, Backup before installation and Load Demo Database are 
not checked. 

 

16 Click the Finish tab and then choose Hidden and No. 

17 Click Install. 

18 Once finished click Done. 

Verification 

LMB Maps can be used in three different ways; each method requires a separate 
test. 

Dashboard Map Display 

1 Check the registry at HKLM\Software\Descartes\LNOS Map Server. 

2 Confirm the new maps are in the list and/or the removed maps are no longer in 
the list. 

3 Login to Route Planner. 
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4 Drag a route or stop onto the map and confirm the map is displayed; it should be 
a beige background with black/blue/red lines for the roads. 

Pathing 

1 This can be determined by logging into Route Planner, going to App Setup > 
System Values. 

2 Search for External. 

3 If UseExternalRouter is 0 LMB maps are used for pathing. 

4 Check the [drive]:\lnos\bin\RMPI.ini. 

5 Search for File1=. 

6 Confirm the new maps are in the list and/or the removed maps are no longer in 
the list. 

7 Login to Route Planner. 

8 Drag route onto the map, right click and choose Refresh. 

9 Verify ETAs seem reasonable. 

Geocoding 

1 Check the [drive]:\lnos\bin\gcpi.ini. 

2 Search for File1= 

3 Confirm the new maps are in the list and/or the removed maps are no longer in 
the list. 

4 Login to Route Planner. 

5 Right click on an unassigned stop with a geocode score > 2550 or choose a stop 
with is currently 2550 or -100 in the state of the new map(s). 

6 Choose Geocode. 

7 Click Geocode, the result should be > 2550. 

8 Source should be ?????.lmb. 
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